# TABLE OF CONTENTS

1 INTRODUCTION.................................................................................................................. 5
  1.1 Installing ArKaos GrandVJ – PC....................................................................................... 5
  1.2 Installing ArKaos GrandVJ – MAC.................................................................................. 5
  1.3 Registering ArKaos GrandVJ............................................................................................ 5
  1.4 Registration process.......................................................................................................... 6
    1.4.1 Activation Code........................................................................................................... 6
    1.4.2 Serial Key.................................................................................................................... 7
    1.4.3 Demo .......................................................................................................................... 7

2 INTRODUCTION TO THE SOFTWARE............................................................................ 8
  2.1 Basics .................................................................................................................................. 8
  2.2 Overview ............................................................................................................................ 8
  2.3 Terminology ....................................................................................................................... 9

3 INTERFACE WALK-THROUGH............................................................................................ 10
  3.1 Browser Panel .................................................................................................................... 11
  3.2 Master Preview ................................................................................................................... 11
  3.3 Banks .................................................................................................................................. 12
  3.4 Parameter Panel ................................................................................................................ 12
  3.5 Layer Preview (mixer mode only) ..................................................................................... 12
  3.6 Tool bar ............................................................................................................................ 13
  3.7 Help Box ........................................................................................................................... 13

4 USING THE APPLICATION.................................................................................................. 14
  4.1 Application Modes ........................................................................................................... 14
    4.1.1 Synth Mode ................................................................................................................ 14
    4.1.2 Mixer Mode ............................................................................................................... 14
  4.2 Controller Mapping ......................................................................................................... 15

5 REFERENCE ........................................................................................................................... 16
  5.1 Managing Cells ................................................................................................................. 16
    5.1.1 Basics ........................................................................................................................ 16
    5.1.2 Triggering and Mapping Cells ................................................................................. 16
    5.1.3 Cell parameters ......................................................................................................... 17
    5.1.4 Cell Parameter Mapping ......................................................................................... 20
    5.1.5 Cell Copy / Paste ..................................................................................................... 20
  5.2 Banks .................................................................................................................................. 21
    5.2.1 Bank Control .............................................................................................................. 21
    5.2.2 Bank Operations ....................................................................................................... 21
  5.3 Layers (Mixer Mode) ....................................................................................................... 22
    5.3.1 Layer Previews ......................................................................................................... 22
    5.3.2 Layer Parameters .................................................................................................... 22
    5.3.3 Layer Control ........................................................................................................... 23
  5.4 The Mapping List ............................................................................................................. 24

6 THE PREFERENCES DIALOG .............................................................................................. 25
  6.1 Display Tab ....................................................................................................................... 25
  6.2 MIDI ................................................................................................................................... 26
  6.3 Performances ................................................................................................................... 26
  6.4 Output ................................................................................................................................ 27
  6.5 Advanced ......................................................................................................................... 27
  6.6 Registration ..................................................................................................................... 27

7 PERFORMANCE AND SETUP CONSIDERATIONS ............................................................ 28
  7.1 Movie Compression ........................................................................................................... 28
  7.2 Widescreen & Multiscreen Presentation ....................................................................... 29
  7.3 Introduction ..................................................................................................................... 29
  7.4 Definitions ........................................................................................................................ 29
    7.4.2 Case Studies .............................................................................................................. 30
    7.4.3 Monitor Setup For Wide Screen Or Multi-Screen Projection .................................. 31
  7.5 Soft-Edge ........................................................................................................................ 37
    7.5.1 Calibration ................................................................................................................ 38

8 SUPPORT, INFORMATION AND CONTACT ...................................................................... 39
  8.1 Solutions ........................................................................................................................... 39
    8.1.1 Users discussion forum ............................................................................................. 39
    8.1.2 Knowledgebase articles ............................................................................................ 39
    8.1.3 Trouble ticket system ............................................................................................... 39
    8.1.4 Distributors and resellers ......................................................................................... 39

9 NOTES .................................................................................................................................. 40
1 INTRODUCTION

Welcome to ArKaos GrandVJ.

GrandVJ is ArKaos’ brand new state-of-the-art video mixing and VJ software, allowing unprecedented control over visual performances.

You can use GrandVJ to perform with visuals just like you would be playing an instrument, either using the computer keyboard, a MIDI controller or a MIDI sequencer. Alternatively, you can also use GrandVJ like an 8 channel video mixer, allowing full and precise control over each individual channel.

Your audience won’t believe their eyes.

1.1 Installing ArKaos GrandVJ – PC

1. To install the ArKaos GrandVJ software, **insert the installation CD into your computer’s CD-ROM drive.**

2. **Double-click on the installation file**, located in the root directory of the CD. This will launch the InstallShield Wizard.

3. **Follow the on-screen instructions.** Please note that the installation program will scan for available video components on your computer prior to installing the software. If there are any components that are not up to date, please install them by clicking on their corresponding buttons before proceeding with the installation.

4. **Once the installation is complete, click “Finish”.** The ArKaos GrandVJ software is now ready to be used.

5. Start GrandVJ by going to **Start ▶ ArKaos GrandVJ ▶ ArKaos GrandVJ.**

6. **Follow the registration procedure** described further in this document.

1.2 Installing ArKaos GrandVJ – MAC

1. To install the ArKaos GrandVJ software, **insert the installation CD into your computer’s CD-ROM drive.**

2. **Click on the ArKaos GrandVJ installer** located on the CD.

3. **Follow the on-screen instructions.**

4. Once installation is complete, you will see a shortcut on the desktop. The application will also appear in your **Applications ▶ ArKaos GrandVJ folder.**

5. **Start GrandVJ.**

6. **Follow the registration procedure** described further in this document.

1.3 Registering ArKaos GrandVJ

Your software comes with an Activation Code. It is very important that you keep this code in a safe place since it is the proof that you own a license and it might be needed later to re-install the software or obtain future upgrades.

**Important:** the Activation Code is not the final code that will unlock the software on your computer. To do so, you will need to obtain a Serial Key by sending us your MachineID code and Activation Code.
The Serial Key is the code that unlocks GrandVJ to run on a specific computer. It is calculated by combining the computer’s MachineID - an 8 letters code that GrandVJ generates and which identifies your computer - and the Activation Code, which is the proof that you own a license.

1.4 Registration process

The registration process is fairly easy. You have the choice to either unlock GrandVJ directly from within the application itself (if you are working on a computer that is connected to the internet) or to use a Serial Key that was obtained from our web site or during a previous installation.

In any case, each Serial Key you generate is sent to you by mail as confirmation so you can keep a trace i.e. if you need to re-install your computer.

When you start the application unregistered, the registration wizard appears.

This dialog allows you to choose the registration method you would like to use or to continue trying GrandVJ in demo mode.

Note that your computer’s MachineID is displayed at the bottom of the dialog; you will only be able to unlock GrandVJ with a Serial Key that was generated for this MachineID.

1.4.1 Activation Code

Choose the first option, “Activation Code”, and press next if you would like to unlock the software directly from the application, through your Internet connection. This option is the easiest but requires that GrandVJ can communicate with our servers and is not blocked by a firewall or network policy restrictions.

Type your Activation Code in the first field. If you have a software box, the Activation Code is printed on a sticker that is attached to the installation CD sleeve. If you purchased a license online, the Activation Code has been sent to your e-mail.

The code is composed of four groups of four capital letters separated by hyphens, so a total of 16 letters / 19 characters.

Here’s an example:

ACBD-EFGH-FGHE-ACDE
In the next fields you need to specify an e-mail address where you will receive an e-mail with a copy of the generated Serial Key.

Once you have verified all the information, press next. The application will try to communicate with our servers to obtain the Serial Key for your computer. If the registration is successful, it will display a confirmation message on your screen.

### 1.4.2 Serial Key

Choose this option if you have already obtained a Serial Key for this computer.

This option is mainly used if the computer where you want to unlock GrandVJ is not connected to the Internet. In that case, you will need to surf to our website with another computer - connected to the Internet - and generate a valid Serial Key for the computer you want to run GrandVJ on. Remember every computer has a different MachineID and a Serial Key will only unlock GrandVJ on the computer with the corresponding MachineID.

**Important:** before surfing to our website to obtain a Serial Key, make sure to take note of the computer's MachineID (displayed at the bottom of the registration window) and have your Activation Code ready.

With a web browser, go to

http://www.arkaos.net/myarkaos/grandvj.php

and follow the instructions there.

After completing the registration process you will receive an e-mail with your GrandVJ Serial Key. The Serial Key is similar to the code below:

```
JAJHJKPKPJEADMIKHOICHBOIDBBGKEHPMADKNGMOPJHPNJBHMKKIANAJFDNIAF
JEKDOIPGGFIOMOOBOOBJMGLFPLDOEGHPMOMDFKHOFAKLOGCHKDBEDACABHPLDKH
DNLCCJCBNBLNLLILGGFBGILFONLMDFDBMPPHFEDFIAJGBOADJBEICNODHEJE
BLKMHDOKDLOCOOFHEJHECJOHNLDCHPEHMIBPNBDCJOJNMOAHPEODDBAGLODAEH
```

The easiest way to transfer that code to GrandVJ is to select the whole code by highlighting it with your mouse then copy it in the clipboard ( [Ctrl]+C on a PC or [Apple]+C on a Mac) and paste it ( [Ctrl]+V on a PC or [Apple]+V on a Mac) in the dialog as shown in the picture on the right.

When you press next your application will be registered.

### 1.4.3 Demo

Choose this option to continue using GrandVJ in demo mode, you will not be able to save your work and a banner will randomly appear in the output and in the master preview.
2 INTRODUCTION TO THE SOFTWARE

2.1 Basics

GrandVJ is a software application which allows you to seamlessly integrate real-time video with any type of performance situation. Serving up to 8 layers of videos and boasting a very wide array of effects and control parameters, it also allows full control of the software via MIDI, Keyboards or external sequencers.

GrandVJ is designed to work using a dual video output computer setup. The main output will display the interface of the software and the previews while the second output will send the full resolution image to an external hardware display like a projector, a plasma screen, a video mixer, etc.

For more information on setting up a proper dual output, see the ‘Preference Dialog’ and the ‘Wide Screen & Multi-Screen Presentation’ sections later in this document.

2.2 Overview

The software is organized along one main window that displays all of the information needed during a performance. It shows the 8 individual layer outputs as well as the master preview (the image which is sent to the full screen output) and a parameter panel with settings for each layer.

Parameters can either be modified through the user interface, from the computer keyboard or from a MIDI controller.

GrandVJ allows you to work with two different distinct modes:

1. The “synth” mode is where you play visuals like you would play an instrument. This is very much like ArKaos VJ 3.x, where you define cells and their properties and you “stack” cells on top each other by pressing simultaneous keys on the computer keyboard/MIDI controller.

2. The “mixer” mode is where you can access the 8 individual layers and control them individually. In this mode, GrandVJ becomes a full-featured 8 layer software video mixer.

When you first start the software, the full screen output is disabled by default. If you want to send the full screen output to the second output of your card, activate full screen either by selecting View ▶ Toggle Fullscreen or by pressing CTRL+F (Command+F on Mac). If you don’t have a proper dual output setup, the full screen will be activated on the main screen and the main interface will disappear. To exit full screen mode, press CTRL+F/Command+F again.
2.3 Terminology

In ArKaos GrandVJ, we’ve slightly changed the terminology used to refer to different application features:

- **Visuals**: Visual is a generic term encompassing everything which produces frames: this can be images, videos, camera streaming, generators or flash animations.

- **Effects**: Effects are real-time processors which allow you to alter visuals. GrandVJ comes with about 50 effects in various categories.

- **Generators**: Generators are sound controlled graphical elements. They react to the sound input from your sound card and are great to provided sound automated textures.

- **Cells**: Cells are placeholders to store a given combination of visuals/effect/transparency/copy mode/position combination. When you ‘trigger’ a cell, you send the content of the cell to the graphic engine. In synth mode, triggering cells stacks them on top of each other. In mixer mode, triggering a cell will send it to the currently selected layer.

- **Banks**: Banks are combination of cells forming a mini library. There are two sets of 16 banks. The first bank set is laid out according to a matrix and referred to as the 'matrix bankset'. The second is shaped as a MIDI keyboard layout and is referred to as the 'keyboard bankset'. The matrix bank size can be changed to match any controller layout you would be using.

- **Layers**: Layers represent stacks in the visual pipeline. Each layer has a set of properties matching the cell properties: one visual, one effect, transparency, copy modes, chroma/luma keying, position etc... GrandVJ is capable of displaying up to 8 layers. In synth mode, layers are assigned automatically depending on the way you trigger cells and their foreground/background property. In mixer mode, you have access to all the layer properties individually.

- **Mapping**: Mappings represent a way to “connect” an element from the software to a control device (MIDI controllers, MIDI sequencers or the computer keyboard). You can map the matrix bank cell triggers, control the layer/cell properties, as well as some of the general controls of the software.

- **Project**: A project is a collection of banks and cell definitions which are stored in a project file for later use.

- **Previews**: Allow you to preview the content of a layer or the main output. The main preview window is always displayed and shows what is sent to the main output. In mixer mode, individual layer previews are also available.
3 INTERFACE WALK-THROUGH

This section describes the different application panels and their functionality. Depending on the mode you are using (synth or mixer), not all panels may be available. Specifically, in synth mode, the layer preview is not available.

Below is a full screenshot of the application:

![Full Screenshot of Application](image)

**Note:** Most panels are resizable to accommodate various screen resolutions and the software will remember different configurations for the synth and mixer mode. If you have enough resolution, you can unwrap the tabs of the parameter panel for example, as in the example above.
### 3.1 Browser Panel

The left side of the application is dedicated to the browser section. The browser section contains five tabs with the following items:

1. **The file browser** allows you to browse the file system of your computer and drag and drop files to a cell, to the visual library or to the layer previews (in mixer mode).

2. **The effect browser** allows you to browse the available effects. Effects are sorted according to categories. The browser allows you to drag and drop effects to a cell or directly to a layer preview (in mixer mode).

3. **The source browser** allows you to browse visual elements; these include generators, flash texts, and cameras available on the system. The source browser allows you to select a source and drag and drop it to a cell or a layer preview (mixer mode only).

4. **The visual library** contains the list of all the visuals that have been loaded in the session, no matter if they’re currently assigned to a cell or not. You can drag and drop a library element to a cell or to a layer preview (mixer mode only). The content of the visual library is saved with the project and restored when the project is loaded.

   If you load a lot of videos, they will keep accumulating in the visual library. To get rid of videos that are neither running nor associated to a cell, select the ‘purge visual’ entry from the edit menu.

5. **The mapping list** provides a summary of activated MIDI and keyboard mappings. It also provides additional options not available through direct mapping, such as setting and type of controller (for example, normal/incremental).

### 3.2 Master Preview

The master preview mirrors the main output of the software. On the bottom of the preview panel, you will also find control to fine tune the brightness and contrast of the resulting image.
3.3 Banks

There are two sets of banks (or banksets). One is in the shape of a MIDI keyboard, the other one is matrix-shaped:

Each bankset contains 16 banks, arranged in tabs. Of those 16, only one is 'active' at a time. The active bank is the bank whose cells will be triggered when you press a keyboard or MIDI controller key. The active bank is marked with a small red sign in its tab. Each bank contains a certain number of cells containing a visual, an effect and various mixing parameters. On the matrix banks, cells can be triggered using one of three methods: Mouse, Keyboard or MIDI. The keyboard banks are only triggered from a predefined MIDI scheme (reflecting its keyboard structure).

The number of cell (horizontally/vertically) in the matrix bank set is user-definable but is the same across all banks.

3.4 Parameter Panel

The parameter panel allows you to edit cell or layer parameters. In synth mode, only the cell parameters will be accessible. In mixer mode, both cell parameters (for cue editing) and layer parameters (to update one of the running layers) will be accessible.

The parameter panel also allows you to set up the MIDI mapping of either cell parameters (synth mode only) or layer (mixer mode only).

3.5 Layer Preview (mixer mode only)

In mixer mode, the layer preview panel allows you to preview layer content. Layers are organized from the bottom up and each layer can be controlled independently. Next to each layer preview are the following elements:

- one transparency slider
- one button to pause/restart the layer
- one button to clear the layer
- one button to map the layer selection and display the layer, if it is running.
3.6 Tool bar

The toolbar provides a series of buttons and displays with the following functionality:

- ![Switch](image) switches to synth or mixer mode
- ![Full Screen](image) activates / deactivates full screen
- ![MIDI](image) displays MIDI activity
- ![Audio Input](image) audio input meter + gain control
- ![Latch/Hold](image) latch / hold (synth mode only)
- ![Kill All](image) kill all (stops all running layers)

3.7 Help Box

The help box is located under the browser section and displays contextual information about the element over which the mouse is hovering.
4 USING THE APPLICATION

4.1 Application Modes

As we mentioned earlier, GrandVJ provides two very distinct modes of operation. It can function as a visual instrument/performance tool or as a video-mixer. It is important to grasp the difference between these modes in order to fully take advantage of them.

Internally, GrandVJ allows for up to 8 layers of stacked video. In synth mode, layer assignment is done automatically depending on the order of triggering and the priority setting of the cell. In mixer mode, the user controls the layer content directly, providing a 8 channel video mixer.

4.1.1 Synth Mode

This is the default mode of operation, which is loaded upon application startup. In this mode, each cell triggered is, by default, stacked “on top” of the previous ones in the graphic pipeline. A cell stays active from the moment it is triggered until it is released.

Cells are linked directly to the graphic pipeline, meaning that if you modify any parameter of a cell running in the engine, it will be reported directly to the graphic pipeline. For this reason, in synth mode, you can map cell parameters to controllers. You could, for example, map the ‘transparency’ setting of a cell to a MIDI controller slider and bring it from invisible to visible once it's been triggered.

It is also possible to assign a ‘priority’ value to cells. The priority has three values: foreground, background and normal. If the cell is assigned a background priority, it will always be ‘stacked’ under normal cells. Alternatively, if the cell is assigned a foreground priority, it will always be stacked on top of the others. This is handy, for example, if you want to have a logo or message continuously running above the rest while you’re playing: simply put the cell in foreground and it will stay on top, no matter what other cells you trigger.

4.1.2 Mixer Mode

Mixer mode works very much like a video mixer. The main difference from the synth mode is that you can decide which layer to send a cell to. Also, once a cell has been triggered on a layer, the layer runs independently from the cell. Contrary to synth mode, modifying cell properties in mixer mode won’t affect layer settings. You can, however, act directly on all the layer parameters. To fade one layer out, you simply select it and use the parameter panel to slowly change its transparency. Once a cell is triggered on a layer, it will run continuously, even when you release the cell's key. To stop a visual from running on a layer, simply press the stop button next to the layer preview.

In this mode, there is always one “selected” layer. The selected layer is the layer which will receive any triggered cell. The currently selected layer can be changed by clicking on any layer in the preview.

In addition to triggering cells on a layer, you can drag and drop visual, effects and sources directly on the layer preview.

As we just explained, in mixer mode, you can still modify cell parameters but these will only be active when the cell is triggered. For this reason, cell parameters cannot be mapped in mixer mode. You can only map layer parameters.
4.2 Controller Mapping

Controller mapping is a very important part of using GrandVJ. Together with external MIDI gear, MIDI sequencers or the computer keyboard, it is the key to creating your perfect live setup.

Controller mapping is fairly easy and can be achieved in two ways:

- The first one is to toggle MIDI or keyboard mapping mode. Once toggled, all mappable controls are highlighted in either green (for MIDI mapping) or blue (for keyboard mapping) and mapping an element from the interface is just a matter of selecting the control and moving the external control or hitting the key that you would like to map. After that is done, exit mapping mode and you will be able to control the parameter directly from the controller.

- The second way is to right click the element you wish to map and choose either 'MIDI mapping' or 'Keyboard mapping'. A dialog will pop up, allowing you to edit the mapping parameters. You can also clear a control mapping by right-clicking it and selecting “clear mappings”.

All the existing mappings are listed in the “mappings” tab of the browser section. You can edit the mappings and delete them directly from there. Selecting a control on the interface will also select the corresponding mapping in the browser.
5 REFERENCE

5.1 Managing Cells

5.1.1 Basics

Cells are the foundation of GrandVJ. Cells work like “cues” where you setup a combination of a visual and/or an effect ready to be triggered at anytime.

To assign a visual to a cell, simply browse your file system for any movie or picture and drag and drop it to the cell of your choice. You can achieve this either from GrandVJ’s integrated browser or from your operating system’s Finder / Explorer.

Note to PC users: by default, when running in full screen, GrandVJ uses a special DirectX mode called “exclusive mode”. The exclusive mode is optimal in terms of performances but has one drawback: if you activate any other application, full screen mode will quit. This prevents you from using the Windows Explorer to drag and drop elements while running in fullscreen. If you wish to use the Explorer (or other applications) while running GrandVJ in fullscreen, go to the Preferences dialog and remove the “force resolution” option (see the ‘Preferences Dialog’ section later in this document).

To assign an effect to a cell, simply go to the “effect” tab in the browser window and drag and drop an effect from the browser onto a cell. When a visual has been assigned to a cell, its thumbnail is displayed in the cell, allowing you to quickly locate it. If an effect has been assigned to a cell, a little lightning bolt is displayed in the top left corner.

Using this technique, you can start building collections of cell that you want to use during your performance. In order to organize your cells, you have two sets of 16 banks: the matrix bankset and the keyboard bankset. The matrix banks can be mapped to any keyboard/MIDI controllers while the keyboard banks are pre-assigned to MIDI notes and cannot be triggered from the keyboard.

5.1.2 Triggering and Mapping Cells

Once you have a set of cells containing visuals and/or effects you can trigger them so that they ‘play’ in the engine. Triggering cells in synth mode and in mixer mode is quite different. In synth mode, a cell stays active until you release the corresponding key. In mixer mode, a cell is “copied” to a mixing layer and will continuously play until you either trigger another cell on that layer or decide to stop it manually (see above for more description of the two modes).

There are 3 ways to trigger a cell:

- using the mouse: simply click on the cell.
- using the keyboard: if a cell is mapped to a keyboard key (the keyboard shortcut is shown on the top right corner of the cell), simply depress the corresponding key.
- using a MIDI controller: if your cell is mapped to a MIDI controller, you can trigger it by just pressing the corresponding key on the controller.

If you don't have any mapping set up (on the matrix bank) you can very easily define a new mapping by toggling the application in 'mapping' mode. Note that the mapping is the same across all banks. If the mapping for the top left cell is 'A' it will be 'A' for all banks from 1 to 16. Cells are always triggered from the active bank, designated by a red tab.
5.1.2.1 Editing Keyboard Mapping

To define/change a keyboard mapping of any controllable element in GrandVJ, the easiest is to toggle the application in keyboard mapping mode. To do so, go to the menu Options ► Edit Keyboard Mapping. All controllable elements will turn blue.

You can edit the mapping of any element by clicking it (it will be surrounded by a black outline) and pressing the keyboard key you would like to assign to it. Exit the keyboard mapping edit mode by selecting Options ► Edit Keyboard Mapping again.

5.1.2.2 MIDI Mapping Mode

To define/change the MIDI mapping of any controllable element, you follow a similar procedure. Toggle the application by selecting Options ► Edit Keyboard Mapping, select a control and activate the key/controller you would like to assign to it. All controllable elements will turn green when editing MIDI mapping.

Additionally, you can edit mappings in the mapping browser window or by right-clicking any controllable element. See the “Mapping” section later in this chapter.

5.1.2.3 Latch and Hold

The latch and hold buttons on the tool bar add flexibility to triggering cells in synth mode. Normally, a cell runs as long as the corresponding keyboard/MIDI key is held down. If latch is activated, triggering a cell will work in a toggling fashion. The first time you trigger the cell, it is activated, the second time it is deactivated. The hold button can be used to 'hold' all running cells, meaning that once the cells have been triggered, you can release the corresponding key(s) and the cells will continue to run, until you retrigger the cells.

5.1.3 Cell parameters

Together with the visual and effect assigned to a cell, you can also define a whole set of parameters that will influence the way your visual is displayed. All of the parameters are contained in the parameter panel and are grouped in four tabs: Visual, Effects, Mixing and Position/Size.

Note that if your screen is big enough, you can undock the tabs and to see all four tab contents at the same time.

To edit the parameters of any cell, simply right-click the cell. The cell will be highlighted to show it is currently being edited.
5.1.3.1 Visual Tab

The visual tab controls what visual is assigned to the cell and how it will be played.

- The visual thumbnail shows the visual assigned to the cell. If you wish, you can directly drag and drop a visual from the file browser on the thumbnail rather than on the cell itself.

- The two arrows on each side of the cell allow you to browse through all the available visuals. This includes any visuals already opened in the project (and listed in the 'Visuals' browser), as well as cameras and generators. Use the left arrow to go to the previous visual and the right one to go to the next one.

- Loop modes allow you to define how the visual will be played back. The modes include, in order: forward loop, backward loop, forward once, backward once, ping-pong, start frame, end frame.

- The speed setting allows you to control playback speed: The center position is 0% (still), all the way to the right is forward at 400% (4 times faster than nominal playback) and all the way to the left is backward at 400%. Note that, like most controls in GrandVJ, you can reset the speed to its default value (nominal playback) by right clicking the control and selecting 'default value'. You can also reset any slider to its default value by using Ctrl+Click [PC] / Alt+Click [Mac].

- The segment widget allows you to define a subset of a movie. The start and end point define which frames will be used for the actual playback region of the movie. Note that it's very handy to setup the playback mode to either 'start frame' or 'end frame' when setting up the segment since it will continuously display the reference point you modify.

- The text setting is only for flash animations that support text replacement. If this field is active, it means you can enter any text to be displayed when playing the flash file.

- The priority setting is only available in synth mode (see earlier in this document for a description of the synth & mixer mode). If the priority is set 'background', the cell will be triggered “under” already running visuals, if it is set to “foreground”, it will run on top of cells that have either a regular or background priority.

5.1.3.2 Effect Tab

The effect tab shows the cell effect and effect parameters.

- Just as the visuals, you can directly drag an effect from the effect browser and drop it on the effect thumbnail.

- You can also browse the effects using the next/previous arrows located alongside the effect thumbnail.

- Each effect can have up to 4 parameters. The parameters and their values are displayed next to the effect thumbnail.
5.1.3.3 Mixing Tab

The mixing tab controls the way the cell are “composited” with the underlying layers.

- The transparency setting controls how the visual will be mixed with the underlying layer. If the transparency is set to zero, the visual will be completely invisible. If it is set to the maximum and no copy/mask mode is selected, the visual will be opaque, possibly hiding them completely. Changing the transparency allows you to do fade ins/fade outs.

- The copy modes express how pixels from the cell are going to be combined with the ones of the underlying layers. In the default mode, pixel colors are mixed together, with a blending value depending on the transparency, like a traditional mixer. GrandVJ also allows you to use other ways to combine the pixels: In addition modes, the pixels from the cell are going to be added to the ones of the underlying layers; In subtraction mode, they will be subtracted; the multiplication mode multiplies pixels together while the two last modes do a luminosity comparison, taking the pixel that has either the lowest or highest brightness.

- The masking modes are used for luminance/chrominance masking. Masking allows you to 'remove' part of the visual based on either the brightness (luminance keying) or color (chrominance keying). Each mode needs the definition of a 'filter' that express which values are let through and which values are not. Depending on whether you choose 'pass' or 'reject' filters, the filter definition will be used to either keep or reject pixels.

Here's the example of a chrominance filter definition:

The color bar allows you to define the center color around which the filter will be computed. Click and drag inside it to change the center/reference color. The top handles specify the width of the color range. The larger it is, the more colors will be passed/rejected. The bottom handles defines the slope or 'smoothness' of the filter. The larger it is, the smoother the transition gradient from passed to rejected colors will be.

- The color settings can be used to change the tint of the visual. Each of the R,G,B sliders remove a certain amount of that component from the original visual.

- The preset button (down arrow) allows you to quickly select a combination of mask mode, copy mode and color settings from a list of presets.
5.1.3.4 Position / Size Tab

The position/size tab specifies how the visual will be positioned on the screen.

- The position setting moves the visual on the screen. The z position acts like a zoom.
- The size setting alters the size of the visual on the screen.
- The rotation parameters specify a 3D rotation of the object on which the visual is mapped. Next to each axis slide is a button which specifies whether the rotation value is an absolute value or a continuous rotation speed.
- The shape controls map the visual on various 3D shapes: you can select between plane, cube or sphere.
- The tiling parameter specifies how many times the visual is to be tiled (repeated) on the 3D shape.
- The preset menu (down arrow) selects predefined combinations for the position/size parameters.

5.1.4 Cell Parameter Mapping

In synth mode only, most cell parameters are mappable. To map any parameter to either a computer keyboard key or MIDI controller, simply toggle the application in MIDI/Keyboard mapping mode; select the control to map and move the desired controller. Note that in mixer mode, the cells parameters are merely 'copied' to a running layer and there is no way to map them to remote control. The live controls in mixer mode are assigned to layer parameters (see further).

All controls can also be reset to their default values by right-clicking on the control and selecting 'default value' from the pop-up menu.

5.1.5 Cell Copy / Paste

In addition to building cells from scratch, there are ways that you can copy content or cell parameters to other cells:

- Dragging one cell to another cell will duplicate all the settings from the source cell to the target cell.
- Right-clicking on a cell allows you to select copy/cut/paste the cell content from/to the clipboard. It will also allow you to clear the cell completely or to remove its effect or visual.

  Please note that since right-clicking a cell is also used to select it for edition, you need to hold the right click for a little while before the menu shows up.

- Alternatively, you can also select a cell and select copy/cut/paste from the menu or use the keyboard shortcut.
5.2 Banks

As seen previously, banks are collections of cells. There are two groups of banks (or bank sets): one is shaped like a keyboard (and is preassigned to MIDI notes) and the other one is in the form of a matrix. The matrix bankset is the only one that can be mapped. The number of row/column in the matrix is also user-configurable by right-clicking in the gray area of the bank and selecting “set matrix size”. The size of the matrix will be changed across all banks. Alternatively, you can also set the matrix size by selecting the menu entry **Options ➤ Set Matrix Size...**

5.2.1 Bank Control

In each bank set, there is always one active bank. The active bank is designated with a red indicator in its tab:

Whenever you trigger a cell from the computer keyboard or a MIDI controller, it is ALWAYS the cell of the active bank that is triggered. All banks share the same trigger mapping settings.

To change the active bank, you can left-click its tab with the mouse or by using a MIDI controllers. To display a bank without making it active, simply right-click its tab with the mouse.

**Note:** *In synth mode, triggering a cell in a new active bank will stop all cells which were running in the previous active bank.*

To define controllers to control the active bank selection, simply switch the application to either keyboard or MIDI mapping mode (using the options menu). You will notice that next to the bank, a special bank mapping panel appears:

This panel provides several ways to control the active bank in each bankset:

- The slider allows a continuous controller to be used to smoothly iterate across all banks.
- The two arrows allow you to map to controllers/keys to next/previous bank in the bankset.
- The 16 number gives the possibility to map a key or a controller to directly select one of the 16 banks.

5.2.2 Bank Operations

Banks can be easily duplicated. The context menu provides the usual copy/cut/paste operations.

You can also export a bank's content to a file and re-import it later. This feature allows you to create a lot of banks according to different themes and load them in your live project as you need them. Keep in mind that loading a lot of video might, in the end, slow down your system so it's a good idea to use the “purge visual” entry in the edit menu to get rid of unused videos taking unnecessary resources. Also, importing banks won't change the size of the matrix layout. If you rely on this feature, try to always use the same configuration.
5.3 Layers (Mixer Mode)

Layer previews are only visible in mixer mode. As we said earlier, mixer mode works differently from the synth mode. In mixer mode, rather than acting on cell parameters, you act directly on the layer parameters. There are eight layers available at all times and all layers are shown in the layer preview panel.

5.3.1 Layer Previews

The layer previews display the state of the different layers, along with a few controls. Each layer has, in order from left to right:

- A layer preview, showing the visual running on the layer
- A transparency slider, allowing direct control of the layer's transparency
- A play/pause button allowing you to temporarily pause the layer and restart it. When paused, the layer will not be displayed.
- A stop button to clear the layer
- A running indicator

You can right click on a layer preview to show a contextual menu which allows you to remove the visual or the effect from the layer.

Layers previews can also be dragged and dropped back onto cell, creating a cue with the current layer settings.

5.3.2 Layer Parameters

In mixer mode, there is always one layer that is selected. The selected layer (in this case 3) is the one that will receive cells that are triggered.

Once a cell has been triggered on a layer, the layer runs independently from it. This means that, to the contrary of the synth mode, once a cell has been ‘sent’ on a layer, changing the cell parameters won’t affect the running layer. You can, however, directly edit the layer parameters. To do so, simply select a layer and the parameter panel will display the layer parameters instead of the cells parameters.

It's important to understand at this point that in mixer mode, the same parameter panel can be used to edit either cells or layer parameters, depending on which one was last selected. Layer 3 here has a blue background, which means that the parameters shown in the panel are layer 3's. Right click on a cell and you will see the cell's background turn blue, showing it's the cell parameters that are being edited.

Layer parameters are the same as the cell parameters, for reference, please read “Cell parameters” further in this document.

In mixer mode, you can also lock some of the layer parameters. Locking parameters means that when you trigger a cell, the locked parameters won't be transmitted to the layer. For example if you set up a transparency setting on the layer, you don't want the transparency setting of the cell to alter the layer. To lock a set of parameters, simply click on the lock icon in the panel.

If the lock icon is closed, all parameters of that panel will become locked. The mixing and size/position are the most useful panels to lock.
5.3.3 Layer Control

5.3.3.1 Controlling Layer Parameters

As for the cell parameters in synth mode, you can map all of the layer parameters through MIDI. Simply toggle the application in MIDI mapping mode, select the parameter to control and move the MIDI controller knob you would like to assign to it.

GrandVJ provides two different modes to control the layer parameters:

- In the default mode, all layers have independently assignable parameters. This means that you can define a separate controller for the red balance on Layer 1,2,3,...,etc. This scheme works quite well if you have a controller that is large or allows you to easily change presets on the fly.

- The other mode allows you to define a ‘template’ of controllers that will always act on the selected layer. In this mode, if you assign the red balance to CC 3, moving CC 3 will always affect the red balance of the selected layer. This makes it easier to control a large set of parameters from a small amount of knobs.

You switch between the two modes by selecting the menu entry Options ▶ Map Selected Layer.

Note that even in the “selected only” mode, you still can access the individual transparency controls on the layer preview panel and map them to separate controllers.

5.3.3.2 Controlling Layer Selection

There are a number of possible ways to control layer selection. When you toggle the application in MIDI/Keyboard mapping, a new panel appears on top of the layer previews:

- The slider allows you to assign a continuous controller to the layer selection.

- The two arrow shaped button allow to map a control for next and previous layer.

- The number next to the layer can also be used to select that layer directly.

Note the two additional buttons in the panel above the layer preview panel. They are used to map ‘pause’ and ‘stop’ selected channel.
5.4 The Mapping List

Through the previous chapters, we’ve seen that it is fairly easy to map MIDI or keyboard control to most software parameters. This easily links a controller to the software. Sometimes, however, a bit more configuration may be needed. The ‘mappings’ tab in the browser section lists all the existing mappings.

Right clicking an entry allows you edit or delete it. If you choose to edit the entry (which you can achieve by double-clicking as well), you will see a dialog like the one shown on the bottom of this page.

The dialog allows you to manually setup the controller type and MIDI channel but also gives you a few more options:

- The circular toggle specifies that the controller is sending incremental values. There are a couple of variants in the MIDI specification so you will have to choose the type of incremental controller: (2 complement, Signed bit, Signed bit 2, Bin Offset)

- The sensitivity is used to calibrate the incremental controllers to react better

- The min & max. values can be used to limit the range of the controlled element. If you put a maximum value lower than the minimum value, the control mapping will be inverted.

Note that you can directly access this dialog by right-clicking on any assignable control and select “edit keyboard mapping...” or “edit MIDI mapping...”
6 THE PREFERENCES DIALOG

The preferences dialog sets various options of the application.

6.1 Display Tab

The “Display” tab specifies how the output is displayed in full screen mode.

- **Full screen monitor** selects the screen adapter to use when the application is toggled in fullscreen. Usually, you will use the second adapter, keeping the interface on the main monitor.

- **Resolution** specifies the resolution that you want to use when running the engine.

- **Force resolution**: This setting has a different meaning on PC and Mac:
  
  On PC, it runs fullscreen in so-called 'Exclusive mode'. This mode is the mode used by most games and is optimal in terms of video performance. However, when engaged, you can't toggle to any other application than GrandVJ. If you do so, fullscreen will quit.

  On MAC, it will change the monitor resolution to fit the setting of the resolution. If you toggle the setting off, only a part of the screen will be covered.

- **Custom resolution**: This setting allows you to use 'exotic' resolutions that don't match the adapter settings. This feature is mainly intended for Mac users to allow spanning of the display across two monitors.

- **Soft-Edge** can be used if you split the engine's output to several beaming devices. In that case, it is good, quality-wise, to overlap the beamer's output and introduce a mixing curve in the overlap zone. The span allows you to specify how many beaming devices will be in use, both vertically and horizontally. The width and curve parameters control the blending zones of the soft edge. See “Widescreen And Multiscreen Presentation" for more details.
6.2 MIDI

The MIDI tab allows you to select which MIDI devices will be enabled for use with the application. Please note that all data from enabled MIDI devices are merged so no matter what interface it comes from, a note on message on channel 1 will have the same effect.

Here, you can also select whether the keyboard banks should be dedicated to one MIDI channel or should listen to all of them.

6.3 Performances

The “Performances” tab configures how previews are handled.

- **GPU Level** gives an indication of the capabilities of your graphic card. If the level is too low, it might be possible that some options become unavailable. The maximum level is 4.

- **Preview Style** defines what is shown in the layer preview in mixer mode. You can choose off, media (default) and full. The media setting will only display the media without applying effects. The full setting will display both the media and the effect applied on it but this will imply that the preview are downloaded back from the graphic card to the main memory which might give a performance hit, especially on PC.

- **Preview Quality** allows you to downsample the preview content quality, if you being to run into decreased performance.
6.4 Output

The “Output” tab configures the key-stoning used for projector output. Key-stoning is used to correct the image if the projector is not totally parallel to the screen.

6.5 Advanced

This tab allows you to set up various advanced options for the software.

- **Auto purge** allows the software to automatically unload visuals that are neither running nor assigned to a cell. You can activate both a purging timer and ask the software to purge when the physical memory available goes under a certain threshold.

- **Enable QuickTime sound** allows you to mix QuickTime videos with sound. Note that this might have an impact on general performance of the software.

6.6 Registration

This tab displays the MachineID for this computer and – if the software is registered - the corresponding Serial Key, in case you wish to back up that information prior to reinstalling your computer for example.
7 PERFORMANCE AND SETUP CONSIDERATIONS

Achieving good performance with video can be difficult because it depends on many different factors.

The most important factors are:

- CPU speed
- Disk speed
- RAM access speed
- Video card & video bus speed
- Movie compression

There is no easy way to give a definitive answer in terms of what is best for every computer setting. In ArKaos GrandVJ, most of the graphic processing is done in the graphic chip of the video hardware, so the more powerful it is, the better performance you are going to get. The CPU is mainly used to decompress movie frames from the disk and send them to the video card. The faster your drives are, the faster frames will be loaded in the memory and the faster your CPU is, the faster it will decompress the frames.

GrandVJ's engine is also heavily multi-threaded. Having several cores will help decompress movie frames in parallel, allowing a faster throughput.

To achieve a good frame rate with a given hardware, you can:

- Adapt the resolution of the engine. See (Preferences/Display)
- Use source material that is adapted to your hardware. If you have a slow disk or older generation of hardware, try working with smaller video sources to minimize the impact of loading and decompressing the movie. Since all calculations are done inside the graphic card, the automatic filtering applied when the images are scaled to the final resolution will minimize aliasing effects.

It is very important to note that popular compressions schemes such as mpeg, divx,DV and vobs, are very inefficient for VJing. Video files using these compression schemes will behave 'correctly' when used at nominal speed (100%), but will be very sluggish if you change their playback speed or play them backwards. If you use these compression formats, you will get poor performance from the software.

7.1 Movie Compression

Besides movie size, compression scheme has a huge impact both on the fluidity of the display and playability. The more complex the compression scheme, the more work the processor will have to do to recover specific frames, which often results in sluggish performance. In addition to the compression method itself, there's the issue of key frames. Most widely spread compression mechanisms work using incremental methods, which means they construct a frame by storing the difference between a frame and the previous one. In order to keep the process from deriving too much from the original material, they store an original frame every now and then, and start coding incremental information from that frame on. These original frames are called 'key frames'. Using sparse key frames will mean that for GrandVJ to access a given frame, it will have to find the previous key frame and process all the intermediate frame differences until it reaches the desired one. As you can imagine, this process is rather slow and prevents fast access to frames, which is very important for backward playback or scratching. That's why compression schemes like mpeg or DivX are not at all suited for video performance.

From our experience, the best compression scheme for video performance is QuickTime’s Photo JPEG with a quality setting of about 80% or more. This will ensure smooth playback, effective scratching and decent file size. If you want to use high definition content (HD) you can also use the H 264 codec, part of Apple QuickTime 7.x.
7.2 Widescreen & Multiscreen Presentation

7.3 Introduction

In a common ArKaos GrandVJ setup, a computer with two video outputs is generally used: one output for the desktop monitor (to display the interface and control the software) and another output which receives the result of the visual mix. The second output is generally connected to a video projector, a large screen or a hardware video mixer.

In this case, you will be using the single second output to send your final mix and, after having defined the adapter to use and its resolution, you are ready to go.

ArKaos GrandVJ, however, also offers custom output resolution possibilities. This allows you to create multi-screen or wide screen setups, controlled by a single computer running ArKaos GrandVJ. In this chapter, we’ll investigate those specific setups.

Important: Wide screen or multi-screen setups require high resolution output and therefore a recent / powerful graphic card is necessary; a setup including 2 screens, each in 1024x768, will require ArKaos GrandVJ to output in 2048x768, which will use a lot of CPU and GPU resources.

7.4 Definitions

7.4.1.1 Wide Screen

A wide screen setup consists of one large visual mix spanning across several screens placed next to the other.

This is achieved by generating a single ArKaos GrandVJ projection in very a large resolution, which spans across several video adapters. If you plan to use projectors as outputs devices, you also have a Soft-Edge option, which allows seamless edge blending between the two projectors.
7.4.1.2 Multi-screen

The multi-screen setup is the same concept as the wide screen in the sense that it drives several adapters but in this case you end up with different visual mixes displayed on each output.

The way it works is that you use the position settings of ArKaos GrandVJ to assign layers to part of the screen, which is divided across the various adapters.

7.4.2 Case Studies

In order to explain the different steps to setup ArKaos GrandVJ to produce a wide screen or multi-screen projection with several displays, let’s examine some common hardware configurations.

7.4.2.1 Case 1: Dual Head Graphic Card

If you only have a dual head graphic card and would like to achieve multiple outputs, you will need to use both adapters and, since you have no more monitor available left, you will lose the interface display.

7.4.2.2 Case 2: Dual Head Graphic Card + Single Head Graphic Card

Adding a supplementary graphic card to the setup described above will allow you to use it with your desktop monitor in order to display the ArKaos GrandVJ interface and control the software while you use the dual head graphic card and its two outputs for the wide screen or multi-screen outputs.

**Important:** at this stage, this option is only available on PC. The Mac version does not support accessing more than one graphic adapter.

7.4.2.3 Case 3: Dual Head Graphic Card + Additional Hardware

Using an external hardware such as the Matrox DualHead2Go allows splitting one video output into two separate signals (the DualHead2Go is a palm-sized box that sits outside of your system and has one VGA input and two VGA outputs).

This system allows computers with a dual head graphic card to use one of the graphic card output for the software interface and its second output to send the visuals that will be split across two different screens. This very affordable solution will also fit perfectly with most modern laptops.

7.4.2.4 Other Possible Combinations

- Dual head graphic card with each output split in two with a DualHead2Go; you would have a 4 screens setup.
- Matrox also provides the TripleHead2Go multi-display upgrade allowing splitting a single display adapter across 3 different screens. This can lead to up to 6 screens if you are using a dedicated two-heads display adapter for the output.
7.4.3 Monitor Setup For Wide Screen Or Multi-Screen Projection

Earlier in this document, we’ve seen how to choose and setup a second monitor to display the ArKaos GrandVJ visual mix. To do wide screen or multi-screen, the principle is the same in the sense that ArKaos GrandVJ will continue to output one large visual mix, but the visual is going to span across the multiple heads of an adapter. The way to execute the span across adapters is very different for Mac and PC’s so we’ll examine them separately.

7.4.3.1 Monitor Setup Under Windows

Under windows, it is the graphic card that is responsible for spanning the big display across the various heads. In a sense, you create one “virtual display” covering two “physical displays”.

In Windows terms, this is called Horizontal Span or Vertical Span, depending on the display orientation you will select.

As an example, we will explain the different steps to configure a virtual display over multiple screens both with nVidia and ATI graphic cards. Other graphic cards may be capable of achieving such a setup and the configuration settings should not be too different from the ones explained below. In any case, please refer to your graphic card manufacturer’s documentation.

Finally, it is important to setup these options before launching ArKaos GrandVJ since the application detects your displays upon startup.
1. **nVidia Graphic Cards**

1. In the Windows Control Panel, open the “Display Properties” window and go to the “Settings” tab. You will see a classic dual monitor setup such as the one below.

2. Click on the “Advanced” button and select the nVidia tab on the top right, this window will open:

3. In the menu next to “nView Display Mode”, select “Horizontal Span” or “Vertical Span” and click OK to apply.

   If you selected “Horizontal Span”, the two physical screens will be merged side by side in a single large display and the Windows display settings window will show a large screen.
4. In this case, the resolution is 2560x1024 because we used two 1280x1024 screens.  
   
   If you selected “Vertical Span”, the two physical screens will be merged on top of each other in a single tall display and the Windows display settings window will show a tall screen.

5. Once you have achieved this setup and closed the display settings window by clicking Ok, you can launch ArKaos GrandVJ. The resolutions available for the adapter will now list the wide set of resolution you created with the horizontal span.
2. ATI Graphic Cards

Setting up Horizontal or Vertical Span with ATI graphics cards is done through the “ATI Catalyst Control Center” which you can launch from Windows’ program menu or from the ATI icon in your system tray (next to the clock in the task bar).

**Horizontal Span**

1. Once the “ATI Catalyst Control Center” window is open, to setup a simple Horizontal Span, select the Basic mode then click Next.

2. The display configuration wizard will be displayed, click Go to start:

3. In the Available Display Devices list, select which one is your primary monitor then click Next.
4. In the Desktop Mode Selection dialog, select the last option “Horizontal Stretch” then click Next.

5. You will end up with a single display spanning horizontally over two monitors. You can now launch ArKaos GrandVJ and select from the new set of available resolutions.

**Vertical Span**

1. To setup a Vertical Span, select “Advanced” instead of Basic on the ATI Catalyst Control Center first screen then click ‘Next’.

2. Select the “Displays Manager” section in the tree menu under the “Graphics Settings” tab; you will see your monitors listed.

3. Right-click on your secondary monitor and select the option “Stretch Desktop 1 vertically onto monitor” from the pop-up menu. Of course, you can also setup a horizontal stretch from that menu.

4. Close the dialog box by clicking Ok. You can now launch ArKaos GrandVJ and select your “virtual monitor” from the Monitors Setup dialog box.
7.4.3.2 Monitor Setup Under Mac OS X

1. From the Apple menu, open the System Preferences and select “Displays”, once in the Displays window, go to the “Arrangement” tab.

It is very important here to ensure that your monitors are represented in the same position as they are physically positioned; you may need to drag the monitors around with your mouse to place them correctly. In this case the primary monitor is placed to the left of the secondary monitor.

**Important:** You will later need to manually specify the resolution corresponding to the sum of your two monitors. So make sure you take note of it at this stage. For example, if you have two monitors of resolution 1024x768 placed side by side, your total resolution will be 2048x768.

You can now close the System Preferences Displays window and launch ArKaos GrandVJ.

2. In ArKaos GrandVJ, go to the Preference Dialog and select the display tab. First, as output monitor, select the monitor that is positioned at the top left of the full display. Then select the custom resolution setting and enter the resolution corresponding to the sum of the two monitors (2048x768 in our example).

3. Start full screen and the window will be created across the two monitors.

To have it correctly spanned across your two monitors it is important that they have been positioned as they should at step 1 and that your ArKaos GrandVJ resolution corresponds to the sum of the resolution of your two monitors.
7.5 Soft-Edge

To create a large screen by combining several video projectors it is important to be able to seamlessly blend the edges between each projection. This can be achieved through the use of the Soft-Edge option as it creates an overlapped area on the border of each screen with a fade on the edge that can be overlapped with the next image.

Here is the original image (a nice view of Prague’s skyline):

And here’s an example of what would be displayed with a two beamers setup:

The areas to blend are displayed in the middle of the visual. Positioning the beamers so that these two areas are superposed will re-create the original picture without any visible separation in the middle of the visual.

Of course, it’s highly recommended to use two identical projectors.

In the “Display Tab” of the Preferences Window, you can access Soft-Edge options, including the number of projectors to be used horizontally and vertically:

Once this has been setup, you can control the soft edging characteristics by changing the width and curve of the soft edge.

The width of the overlapping area is defined between 2% and 50% of one screen size.

The curve factor defines the fade curve value, allowing you to fine-tune the luminosity of the overlapping area compared to the rest of the picture.
7.5.1 Calibration

Below are the common steps to setup a wide screen with Soft-Edge in ArKaos GrandVJ (provided that you have correctly setup your system and your graphics card driver parameters as explained earlier in this document).

1. Launch ArKaos GrandVJ.
2. Setup the number of horizontal and vertical screens, and the soft-edge settings in the “Display tab” of the Preferences Window.
3. Import a picture appropriate for calibration and activate it.
4. Launch the full screen mode ([Ctrl]+A or [Apple]+A in ArKaos GrandVJ) (At this point, you should have the picture displayed on the two beamers with the soft-edge effect).
5. Place the beamers correctly so that the edges blend seamlessly.
6. Adjust the Curve parameter to obtain the desired luminosity of the overlapping area.
8 SUPPORT, INFORMATION AND CONTACT

<table>
<thead>
<tr>
<th>Users discussion forum</th>
<th>Support centre / Knowledgebase</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://forum.arkaos.net/">http://forum.arkaos.net/</a></td>
<td><a href="http://support.arkaos.net/">http://support.arkaos.net/</a></td>
</tr>
</tbody>
</table>

8.1 Solutions

As always, we are eager to hear from you. If you have any problems or questions, don't hesitate to join our forums or to contact our support team!

8.1.1 Users discussion forum

If you just want to discuss with other ArKaos users, share tips and experiences about our products or third party software / hardware, ask questions about particular setups etc.. Our Users discussion forum is the place to be!

8.1.2 Knowledgebase articles

Our online Support Centre features a FAQ / Knowledgebase where a solution to the most common registration / configuration problems has been posted.

8.1.3 Trouble ticket system

Our online Support centre also features a Trouble ticket system which allows our team to receive your support requests and follow up the resolution of your problem as well as eventual future issues. You can check the status of your trouble tickets, post replies to our team or create new trouble tickets directly from our web interface.

Our support team answers your requests during office hours (CET) on weekdays, we do our very best to answer your trouble tickets within one business day.

8.1.4 Distributors and resellers

Our distributors and resellers are also at your service if you would like to request information in your language, advice on additional hardware or software, solutions or quotes for a particular configuration etc..

A complete list of distributors and resellers for our software can be found on our web site.

Thank you very much for your interest in our products, we hope you will enjoy using this software as much as we enjoyed creating it!

Have fun!

The ArKaos Team
<table>
<thead>
<tr>
<th>S</th>
<th>T</th>
</tr>
</thead>
<tbody>
<tr>
<td>Segment</td>
<td>Text</td>
</tr>
<tr>
<td>..........................</td>
<td>..........................</td>
</tr>
<tr>
<td>18</td>
<td>18</td>
</tr>
<tr>
<td>Sequencer</td>
<td>Thumbnail</td>
</tr>
<tr>
<td>8, 9, 15</td>
<td>18</td>
</tr>
<tr>
<td>Serial Key</td>
<td>Tiling</td>
</tr>
<tr>
<td>6, 7, 27</td>
<td>20</td>
</tr>
<tr>
<td>Shape</td>
<td>Toolbar</td>
</tr>
<tr>
<td>..........................</td>
<td>13</td>
</tr>
<tr>
<td>20</td>
<td>Transparency</td>
</tr>
<tr>
<td>Size</td>
<td>12, 19, 22</td>
</tr>
<tr>
<td>..........................</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Soft-Edge</td>
<td>Vertical span</td>
</tr>
<tr>
<td>25, 29, 37</td>
<td>31, 33, 35</td>
</tr>
<tr>
<td>Sound</td>
<td>Visuals</td>
</tr>
<tr>
<td>9, 27</td>
<td>9, 11, 18, 27</td>
</tr>
<tr>
<td>Source</td>
<td></td>
</tr>
<tr>
<td>..........................</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
</tr>
<tr>
<td>Speed</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
</tr>
<tr>
<td>Sphere</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Stop</td>
<td></td>
</tr>
<tr>
<td>14, 22</td>
<td></td>
</tr>
<tr>
<td>Support</td>
<td></td>
</tr>
<tr>
<td>39</td>
<td></td>
</tr>
<tr>
<td>Synth mode</td>
<td></td>
</tr>
<tr>
<td>8, 14</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>T</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>W</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>W</td>
<td></td>
</tr>
<tr>
<td>Wide screen</td>
<td>29</td>
</tr>
</tbody>
</table>